
Note:	 For the absolute latest Information and Updates on all Products, Materials,
		  Processes, and/or Procedures relative to all offerings by or through Sawgrass
		  Technologies, Inc., Please	 refer to our Website: www.sawgrassink.com.

Rev 2.0





iii
Sawgrass Technologies, Inc. ~ Epson® WorkForce 30/T30/B40W ~ ChromaBlast™  

ChromaBlast™
Getting Started Guide for the

EPSON Workforce 30 / Office T30 / Office B40W

© Copyright 2009, Sawgrass Technologies, Inc., Revision March 2009.

All rights reserved.

Printed in the United States of America.

ChromaBlast™ & ChromaBlast™ Driver are Trademarks of Sawgrass Technologies, Inc.,
Epson® and Stylus® are Registered Trademarks of Seiko Epson Corporation.

Other trademarks and registered trademarks are the property of their respective owners.

No part of this manual may be reproduced or transmitted in any form by any means 
without the prior written consent of Sawgrass Technologies, Inc.  Information in this 
manual is subject to change without notice and does not represent a commitment on the 
part of Sawgrass Technologies, Inc.



Sawgrass Technologies, Inc. ~ www.sawgrassink.com
iv

IMPORTANT – READ CAREFULLY:
This PROCESS LICENSE AGREEMENT (“PLA”) is a legal agreement between you and Sawgrass 
Technologies, Inc. (“Sawgrass”).  By installing the ChromaBlast Ink in your printer, or otherwise 
using the Sawgrass ChromaBlast Ink, you agree to be bound by the terms of this PLA.  If you 
do not agree to the terms of this PLA, Sawgrass is unwilling to license the process of using 
the ChromaBlast Ink to you.  In such event, you may not use the ChromaBlast Ink, and you 
should promptly contact your supplier for instructions on return of the unopened package.

The process of using the ChromaBlast Ink is protected by U.S. and foreign patents.  
Sawgrass will provide a complete list of the relevant patents upon request.  The use 
of the ChromaBlast  Ink to practice the patented process is permitted by this license.

GRANT OF LICENSE — This PLA grants you the following rights:  You may install and use the 
ChromaBlast Ink packaged herewith in your EPSON printer to practice the printing process 
described in U.S. Patent No. 6,341,856.  The use of any ink, dye, or pigment to practice the Sawgrass 
Process, other than a ChromaBlast Ink purchased from Sawgrass or its authorized distributor 
accompanied by a PLA, is not a licensed use of the Sawgrass Process.  No rights to use the Sawgrass 
Process, except those specified herein, are granted, and no rights to use any other process, 
product, software, or hardware developed or sold by Sawgrass are granted or implied hereby.

LIMITATIONS ON REVERSE ENGINEERING — You agree that you will not attempt to reverse 
engineer, reproduce, or deformulate the ChromaBlast Ink.

PATENTS AND COPYRIGHTS — Sawgrass owns multiple U.S. and foreign patents which 
apply to the Sawgrass Process and/or the ChromaBlast Ink or its use.  All patents in and to 
the ChromaBlast Ink and the method of using the ChromaBlast Ink are owned by Sawgrass 
Technologies, Inc.  You may not copy the printed materials accompanying the ChromaBlast Ink. 
All rights not specifically granted under this PLA are reserved by Sawgrass Technologies, Inc.

Made In U.S.A.

CAUTION:

	 •	 For best printing results, use the ink within six months of purchase. Please refer to the
		  individual ink bag/cartridge for the specific ink expiration date.

	 •	 Keep out of reach of children.

	 •	 Do not expose ink to temperatures above 100° F or below 40° F.

	 •	 Keep ink out of direct sunshine.

Sawgrass Technologies, Inc. agrees to replace any defective ink within a reasonable time, which 
shall be Sawgrass’ sole responsibility for errors or defects in these goods.

THERE ARE NO OTHER WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, BUT NOT 
LIMITED TO, ANY IMPLIED WARRANTY OF MERCHANTABILITY OR ANY IMPLIED WARRANTY 
OF FITNESS FOR A PARTICULAR PURPOSE. SAWGRASS SHALL NOT BE LIABLE FOR LOSS 
OF PROFIT OR OTHER ECONOMIC LOSS, OR FOR INDIRECT, SPECIAL, CONSEQUENTIAL OR 
OTHER SIMILAR DAMAGES.
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Sawgrass Technologies, Inc. Limited Warranty
QuickConnect & EasyFlow Bulk Ink Systems
What Is Covered:
Defects in materials and/or workmanship.

Length of Warranty Coverage: 
The warranty coverage for the Bulk Ink System is one year from date of purchase. Any Bulk Ink 
System not purchased from Authorized Sawgrass Resellers is not covered.

How to get service:
Please contact Sawgrass Technologies Technical Support at (888) 253-1679 or an Authorized 
Sawgrass Reseller. A technical support representative will troubleshoot the issue and provide 
instructions on how to get a replacement if necessary.

What we will do:
Provide you, at the discretion of Sawgrass Technologies, with either replacement parts for your 
existing Bulk Ink System unit, a new Bulk Ink System unit, or at our option, a refurbished Bulk 
Ink System unit.  The exchange is under warranty for the remainder of the original products’ 
warranty period or 90 days, whichever is longer. The replacement will be shipped to you via 
ground shipment.  Any rush shipments will be freight prepaid.

What your warranty does not cover:
Damage from misuse or neglect. Damage caused by use outside of Sawgrass Technologies 
recommendations.

Limitations of Warranty:

THERE ARE NO OTHER WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO, ANY IMPLIED WARRANTY OF MERCHANTABILITY OR ANY IMPLIED WARRANTY
OF FITNESS FOR A PARTICULAR PURPOSE. SAWGRASS SHALL NOT BE LIABLE FOR LOSS
OF PROFIT OR OTHER ECONOMIC LOSS, OR FOR INDIRECT, SPECIAL, CONSEQUENTIAL OR
OTHER SIMILAR DAMAGES.

Our Commitment:

	 • 	 Provide the Highest Level of Quality & Proactive Service to YOU, our Valued Customer.

	 •	 To Provide YOU with the Tools, Skills, Support and Solutions to Effectively Improve
		  YOUR Bottom Line.
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D-USER LICENSE AGREEMENT FOR SAWGRASS 
SOFTWARE ChromaBlast Driver 

IMPORTANT — READ CAREFULLY:	 This Sawgrass Technologies Inc. End-User License 
Agreement (“EULA”) is a legal agreement between you (either an individual or a single entity) 
and Sawgrass Technologies, Inc. for the Sawgrass Software Product identified above, which 
includes computer software and may include associated media, printed materials, and “online” or 
electronic documentation (“SOFTWARE PRODUCT”). By installing, copying, or otherwise using 
the SOFTWARE PRODUCT, you agree to be bound by the terms of this EULA. If you do not agree 
to the terms of this EULA, do not install or use the SOFTWARE PRODUCT.

SOFTWARE PRODUCT LICENSE — Copyright laws and international copyright 
treaties, as well as other intellectual property laws and treaties protect the SOFTWARE 
PRODUCT. The SOFTWARE PRODUCT is licensed, not sold.  The title to, and ownership 
of, this SOFTWARE PRODUCT remains with Sawgrass Technologies, Inc. (Sawgrass).

GRANT OF LICENSE — This EULA grants you the following rights:
•	 This license is provided to you for your use according to the terms hereof.  You may install
	 and use the SOFTWARE PRODUCT packaged herewith to practice the printing process
	 described in U.S. Patent No.  5,488,907 (the "Sawgrass Process").  The use of any ink,
	 dye or pigment to practice the Sawgrass Process, other than a NaturaLink Ink
	 that is purchased from Sawgrass or its authorized distributor, is not a licensed
	 use of the SOFTWARE PRODUCT. You agree not to use the SOFTWARE PRODUCT
	 for any other purpose or in any process except as expressly permitted hereby. 

•	 Not for Resale–You may not sell, or otherwise transfer for value, the SOFTWARE PRODUCT.

•	 No Reverse Engineering, Decompilation, Copying or Disassembly–You may not reverse
	 engineer, decompile, copy or disassemble the SOFTWARE PRODUCT.	
•	 No Rental–You may not rent, lease, or lend the SOFTWARE PRODUCT. 

•	 Support Services–Sawgrass Technologies, Inc. may provide you with support services
	 related to the SOFTWARE PRODUCT ("Support Services"). Use of Support Services
	 is governed by the Sawgrass Policies and Programs described in the Getting Started Guide, in
	 "online" documentation, and/or in other Sawgrass-Provided materials. Any supplemental
	 software code provided to you as part of the Support Services shall be considered part of 
	 the SOFTWARE PRODUCT and subject to the terms and conditions of this EULA. With respect
	 to technical information you provide to Sawgrass as part of the Support Services, Sawgrass
	 may use such information for its business purposes, including for product support and
	 development. Sawgrass will not utilize such technical information in a form that personally
	 identifies you.

•	 No Assignment or Sublicense–You may not assign or sublicense the rights granted hereby.  

•	 Termination–Without prejudice to any other rights, Sawgrass may terminate this EULA 
	 if you fail to comply with the terms and conditions of this EULA. In the event of termination, 
	 you must destroy all copies of the SOFTWARE PRODUCT and all of its component parts.
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COPYRIGHT–All title and copyrights in and to the SOFTWARE PRODUCT (including but 
not limited to any images, photographs, animations, video, audio, music, text, and "applets" 
incorporated into the SOFTWARE PRODUCT), the accompanying printed materials, and 
any copies of the SOFTWARE PRODUCT are owned by Sawgrass Technologies, Inc. or 
its suppliers.  Copyright laws and international treaty provisions protect the SOFTWARE 
PRODUCT.  Therefore, you must treat the SOFTWARE PRODUCT like any other copyrighted 
material, except that you may install the SOFTWARE PRODUCT on a computer for the uses 
permitted hereby. You may not copy the printed materials accompanying the SOFTWARE 
PRODUCT.   You may not loan, rent, lease, or otherwise transfer the other medium to another 
user, except as part of the permanent transfer (as provided above) of the SOFTWARE PRODUCT.

U.S. GOVERNMENT RESTRICTED RIGHTS–The SOFTWARE PRODUCT and documentation 
are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the Government is 
subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data 
and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of 
the Commercial Computer Software-Restricted Rights at 48 CFR 52.227-19, as applicable.

MISCELLANEOUS:
a. If you acquired this product in the United States, this EULA is governed by the laws of 
the State of South Carolina.  In the event of any dispute arising under this license or from 
the use of the SOFTWARE PRODUCT, each party irrevocably agrees to the jurisdiction of 
the United States District Court for the District of South Carolina, Charleston Division. 
b. If you acquired this product in Canada, this EULA is governed by the laws of the Province 
of Ontario, Canada. In the event of any dispute arising under this license or from the use of 
the SOFTWARE PRODUCT, each party irrevocably agrees to the jurisdiction of the courts 
of the Province of Ontario and further agrees to commence any litigation that may arise 
hereunder in the courts located in the Judicial District of York, Province of Ontario. 
c. If this product was acquired outside the United States, then local law may apply.

LIMITED WARRANTY–Sawgrass warrants that (a) the SOFTWARE PRODUCT will perform 
substantially in accordance with the accompanying written materials for a period of thirty (30) 
days from the date of receipt, and (b) any Support Services provided by Sawgrass shall be 
substantially as described in applicable written materials provided to you by Sawgrass, and 
Sawgrass support engineers will make commercially reasonable efforts to solve any problem 
issues. Some states and jurisdictions do not allow limitations on duration of an implied 
warranty, so the above limitation may not apply to you. To the extent allowed by applicable 
law, implied warranties on the SOFTWARE PRODUCT, if any, are limited to thirty (30) days.

CUSTOMER REMEDIES–Sawgrass' and its suppliers' entire liability and your exclusive 
remedy shall be repair or replacement of the SOFTWARE PRODUCT that does not meet 
Sawgrass' Limited Warranty and which is returned to Sawgrass with a copy of your 
receipt. This Limited Warranty is void if failure of the SOFTWARE PRODUCT has resulted 
from accident, abuse, or misapplication. Any replacement SOFTWARE PRODUCT will be 
warranted for the remainder of the original warranty period or thirty (30) days, whichever is 
longer. Outside the United States, neither these remedies nor any product support services 
offered by are available without proof of purchase from an authorized international source.
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NO OTHER WARRANTIES–To the maximum extent permitted by applicable law, Sawgrass 
and its suppliers disclaim all other warranties and conditions, either express or implied, 
including, but not limited to, implied warranties of merchantability, fitness for a particular 
purpose, title, and non-infringement, with regard to the SOFTWARE PRODUCT, and the 
provision of or failure to provide Support Services.  This Limited Warranty gives you specific 
legal rights. You may have others, which vary from state/jurisdiction to state/jurisdiction.

LIMITATION OF LIABILITY–To the maximum extent permitted by applicable law, in no event shall 
Sawgrass or its suppliers be liable for any special, incidental, indirect, or consequential damages 
whatsoever (including, without limitation, damages for loss of business profits, business interruption, 
loss of business information, or any other pecuniary loss) arising out of the use of or inability to use the 
SOFTWARE PRODUCT or the provision of or failure to provide Support Services, even if Sawgrass 
has been advised of the possibility of such damages. In any case, Sawgrass' entire liability under 
any provision of this EULA shall be limited to U.S. $5.00. Because some states and jurisdictions 
do not allow the exclusion or limitation of liability, the above limitation may not apply to you.

ChromaBlast™, ChromaBlast Driver™, and ColorSure™  are Trademarks of Sawgrass 
Technologies, Inc.  
                        
General Notice: Other product names used herein are for identification purposes only and may
be trademarks of their respective owners.  Sawgrass Technologies, Inc. disclaims any and all 
rights in those marks.
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Introduction
Congratulations on your purchase of ChromaBlast Digital Transfer Inks. The 
ChromaBlast Ink Cartridges are the latest advancement for the EPSON WF30/T30/
B40W from Sawgrass Technologies, Inc., a leader in the development of digitally driven 
color transfer technologies and related products. 

With this system, your printed images can be transferred onto any natural fiber product 
designed to accept thermally transferred dyes including: t-shirts, caps, coats, bags,  
purses, sweats, etc. resulting in attractive, durable products. Your imagination is the 
limit for producing brilliant, near photo-quality images, graphics and more. ChromaBlast 
is ideal for markets that personalize, customize or create short-run output.

In addition, your system is bundled with ChromaBlast Driver, a user-friendly color 
management software package that allows the user to create flawless transfers in less 
time. Design time is also condensed by utilizing the ColorSure Palette. The color palette 
contains more spot colors and the custom palette gives users the ability to add, edit, 
import or export colors, thus streamlining the color matching process. Instructions for 
installation and use of this system can be found in this User’s Guide.

This document contains information for using ChromaBlast Inks and helpful tips are 
also provided for getting the best results from your transfers.  The information provided 
pertains only to the use of ChromaBlast in your EPSON WF30/T30/B40W Printer.  If you 
have questions about the operation of your EPSON Printer, refer to the EPSON WF30/
T30/B40W Printer User’s Guide.

Technical Support is available from your Authorized SubliJet Reseller or directly from 
Sawgrass Technologies, Inc.  See the section entitled Technical Support for additional 
information.

We at Sawgrass strive to provide you with the tools to make the sublimation process 
easy to learn and simple to master. We hope you will find that the tools we have developed 
will make your years in the sublimation business fun and profitable. Please feel free to 
contact us with your feedback about our products. For additional information on our 
other products, visit our web site at www.sawgrassink.com. 

Thank you and enjoy your ChromaBlast Printing System.
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About this Document
		  This document contains descriptions and procedures for using ChromaBlast
		  Inks, along with additional information for getting the best results from your
		  transfers. The documentation provided pertains only to the use of ChromaBlast
		  Inks in your EPSON WF30/T30/B40W Ink Jet Printer.  To assist you in the
		  overall setup process, references are made back to the EPSON WF30/T30/B40W
		  Printer Basics Guide for instructions. To help point out important information, 
		  specific instructions, and helpful tips, look for the following symbols:
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Installing ChromaBlast™ Cartridges

1.	 Make sure the printer is on.

2.	 Open the printer cover.

3.	 Press and release the Ink Button .The
	 power and ink lights flash.

4.	 Press the Ink Button again  for one
	 second to move the print head into the
	 cartridge replacement position.

Do not hold the Ink Button for more than 3 seconds  or 
the printer will clean the print head. Do not move the 
print head by hand. Do not open the cartridge cover 
when the print head is moving.

5.	 Open the cartridge cover.
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6.	 Squeeze the tab at the back of the Epson
	 Cartridge and lift it straight out. Remove 

all Epson cartridges from the cartridge 
holder.

7.	 DO NOT, IN ANY WAY, SHAKE OR
	 OTHERWISE AGITATE CARTRIDGES, 

BEFORE OR AFTER INSTALLATION.

8.	 Remove the yellow tape from the 
bottom of the ink cartridge.

9.	 Place the new ink cartridge into the 
	 cartridge holder and push it down 	

until it clicks into place.



7Sawgrass Technologies, Inc. ~ Epson® WorkForce 30/T30/B40W~ ChromaBlast™ 

10.	Once the ChromaBlast cartridges are in
	 place, close the ink cartridge cover and
	 press it until it clicks into place.

11.	Close the printer cover.

12.	Press the ink button  for one (1) 		
	 second. The printer begins charging 	
	 ink and the power light starts flashing. 	
	 This takes about 1 ½ minutes. When it’s
	 finished, the power light stops flashing 	
	 & remains on, & the ink light goes out.

Never turn off the printer while the power light is flashing 
or you’ll waste ink. If the ink light stays on (not flashing), 
the ink cartridge may not be installed correctly. Press 
the ink button again and reinstall the ink cartridge until it 
clicks into place.
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Replacing an Empty Cartridge
Make sure you have a new ink cartridge before
you begin. Once you begin the replacement,
you must complete all the steps in one session.

1.	 Make sure the printer is on.

2.	 Open the printer cover.

3.	 Press and release the ink button . The
	 power and ink lights flash. If one of the
	 cartridges is low or expended, the printer
	 moves that cartridge to the expended ink
	 mark. If none are low or expended, the
	 ink cartridge holder moves to the ink
	 replacement position.

4.	 Press the ink button  again. If another 
	 cartridge is low or expended, it moves
	 to the expended ink mark. Once the printer
	 identifies all of the low or expended ink
	 cartridges, the print head moves to the
	 ink cartridge replacement position.

5.	 Open the cartridge cover.
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6.	 Squeeze the tab at the back of the Epson
	 Cartridge and lift it straight out. Dispose 	

of it carefully.

7.	 DO NOT, IN ANY WAY, SHAKE OR
	 OTHERWISE AGITATE CARTRIDGES,
	 BEFORE OR AFTER INSTALLATION.

8.	 Remove the yellow tape from the bottom
	 of the ink cartridge.

9.	 Place the new ink cartridge into the
	 cartridge holder and push it down until 
	 it clicks into place.



Sawgrass Technologies, Inc. ~ www.sawgrassink.com
10

10.	Once the ChromaBlast cartridges are in
	 place, close the ink cartridge cover and
	 press it until it clicks into place.

11.	Close the printer cover.

12.	Press the ink button  for one (1) second.
	 The printer begins charging ink and the
	 power light starts flashing. This takes
	 about 1 ½ minutes. When it’s finished,
	 the power light stops flashing and remains
	 on, and the ink light goes out.

Never turn off the printer while the power light is flashing 
or you’ll waste ink. If the ink light stays on (not flashing), the 
ink cartridge may not be installed correctly. Press the ink 
button again and reinstall the ink cartridge until it clicks 
into place.
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Bulk Ink System ChromaBlast QuickConnect 
Setup for the WF30/T30/B40W
Check to ensure that you have all of the components 
necessary to setup your QuickConnect system:
	 • 	 Bulk Ink Dampers & Tubes 
	 • 	 Plastic Arm with Velcro Adhesive
	 • 	 4 Plastic Syringes for Priming 
	 • 	 3 Plastic Dividers
	 • 	 PowerDriver CD
	 • 	 QuickConnect Box
	 • 	 ChromaBlast Ink bags (not included 	
		  with QuickConnect system)
	 • 	 Printer

1. Remove the soft protective cap from each 
ink bag. Depress the metal tab on the inside of 
the Quick Connect box and insert the plastic 
ink valve into place. Release the metal tab to 
lock the bag into place. Insert the black plastic 
dividers to separate between the four ink bags.

Note: There are 5 (five) bulk ink dampers, but 
only 4 ink bags. Two dampers are supplied by 
the Black ink bag.  The Black ink bag has a “Y” 
tube splitter that fills both black ink dampers.

2. Set the bulk ink dampers face down on a flat 
surface with the round openings facing up. Pierce the 
thin plastic tab that covers the opening using the tip 
of the syringe or a sharp object such as a ball point 
pen. Firmly insert the tip of the plastic syringe into the 
gasketed opening until the tip is completed inserted.

Note: The plunger needs to be completely 
inserted into the syringe.

Before you begin:
It is crucial that the OEM ink supplied with your printer is
installed before you attempt to install your ChromaBlast Inks.
This allows for two things: First,it primes the inkdelivery
system, ensuring that the ChromaBlast Ink will load more
easily. Second, it familiarizes you with the basic operation
of your printer.  Please see the EPSON Stylus WF30/T30/
B40W Printer User’s Guide for instructions on installation.
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3. Slowly extract the plunger. Ink will start to flow 
through the tubing into the damper. Continue
extracting the plunger until ink begins 
to flow into the tip of the syringe.

Note: You may have to repeat this process twice 
to complete the priming of each ink damper.

Repeat this process for the other four channels.

Note: You may have to take the syringe out, lower the plunger and reinsert 
it into the damper in order to completely prime the damper cartridges.

Once the ink bags have been connected your QuickConnect Bulk Ink System should 
look like the graphic above.
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Printer Setup for the WF30/T30/B40W

1. 	 Turn the printer on. Wait for 
the printer to complete its start-up 
procedure. Lift the lid, and press the ink 
button . The ink cartridge bay will shift 
into a position on the right.

3.	 Firmly grasp the lid and twist it 
sideways until it becomes dislodged. 
The lid will not be needed for proper 
functioning of the printer with 
either the Quick Connect system 
or individual ink cartridges.

5. 	 Remove the printer cover panel by 
inserting a flat head screwdriver between 
the panel and the printer. Gently push the 
cover panel loose.

2. 	 Raise the lid of the ink cartridge bay.

4.  	The ink cartridge bay should look 
like the picture above after removing the 
ink cartridge cover.

6. 	 Insert the flat head screwdriver into 
the opposite side of the printer. Hold the 
cover panel with one hand, gently push 
the cover panel loose and remove it.
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7.	 Place the ink dampers into the 
empty ink bay cartridge. The Black ink 
damper should be on the far left side, the 
yellow on the far right side.

9.	 Install the plastic support arm. First 
remove the adhesive backing on the back 
of the plastic arm.

11.	The plastic arm should be aligned so 
that the edge of the adhesive Velcro® is 
situated at the top right hand corner of 
the ink cartridge bay. Press the plastic 
arm firmly to set the adhesive Velcro® 
in place.

8.	 Firmly push down the plastic 
cartridge set of dampers to completely 
engage the ink dampers into place.

Note: You will have to push each 
individual damper hinge into position 
until it clicks into place. The printer will 
not ‘recognize’ the ink damper until it is 
firmly pushed into place.

10.	The plastic tubing comes pre-
attached to the plastic arm with two 
adhesive bands. Position the plastic arm 
on the far right side of the printer.

12.	Press printer ink button  (second 
button on the left side of the printer). The 
printer will start to prime and reset itself. The 
ink cartridge carriage will move in position.

Congratulations! You have installed your WF30/T30/B40W Quick Connect 
bulk ink system. You are now ready to install the ChromaBlast Driver Software.
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•	 Read the documentation on installing and using your
	 PowerDriver WF30/T30/B40W IQ Driver.

•	 Perform a nozzle check from the Epson driver utility –
	 a few cleanings may be necessary to prime the system.

•	 You may have a little air in your lines but this will clear 
	 after a few prints.

•	 If you are going to leave your system without using it for
	 several days, you should turn the plastic valves on the ink 
	 bags to the shut/off position.

•	 Do not raise the ink box higher than the printer.

•	 If the printer’s red in-out light (middle light on the front 
	 panel) stays lit, then remove the ink cartridge damper and
	 reinstall it making sure to firmly press each ink cartridge
	 into place.
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CHIP RESET INSTRUCTIONS

The ChromaBlast QuickConnect bulk ink system for the Epson WF30/T30/B40W 
printer contains a cartridge with five individual dampers that is used in place of the 
individual OEM (Epson) cartridges. This bulk ink system cartridge has a single chip 
that periodically needs to be reset so that the printer can continue to use ink from the 
bulk ink system. The frequency of this reset action will depend upon the number of 
images that are printed and the printer settings.

The following are simple instructions for resetting the bulk ink system.

 

 

 

 

 

 

1. Once the printer recognizes that 
the ink levels have reached a certain 
level, it will cease to print and the 
orange ink-out light will start to flash.

 

 

4. Again, press the ink out button 
on the front of the printer.

3. Press the white reset button at the 
top of the bulk ink system ink cartridge. 

2. Press the ink-out button until the 
ink carriage moves into the far right 
position. The ink carriage will come 
to rest in the carriage bay area.

5. The printer will begin to reset and 
recharge. After the printer has completed 
the resetting activity, the orange light 
will turn off. At this point the bulk ink 
system has been successfully reset and 
the printer is again ready for use.

ChromaBlast / ChromaBlast-R (Suggested Press Parameters)
U.S. Europe

Temperature 375°F - 400° F 190°C - 204°C

Pressure 60 psi (High) 4.22 kg/cm2; 4.14 bar

Time 40 sec – 25 sec 40 sec – 25 sec
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ChromaBlast Printing and Heat Transfer Instructions

RECOMMENDED APPLICATIONS

White or light colored 100% cotton fabrics.

ChromaBlast Transfers: Step-By-Step

Once your ChromaBlast System is set up and in place, printing and 
transferring an image onto a white or light colored 100% cotton garment 
is a breeze. Just follow these simple steps, and you are on your way 
to creating one-of-a kind, beautiful and profitable products.

1.) 	Import an image (it could be a photograph from a digital camera) into 
your graphics application and manipulate it to suit your desired result. 
Manipulation may include sizing the graphic, setting the proper page 
margins and borders for printing or applying color correction if required.

2.) Load ChromaBlast paper into your printer.  The printable 
side is opposite the ChromaBlast logo.

3.) Click Print in your application and select the ChromaBlast driver as 
the printing device. Ensure that the Mirror option is selected, unless 
you have already reversed the image in your graphics application.

4.) Adjust your heat press settings.  See chart below for suggested settings.

5.)	Place the garment on the heat press, and place the ChromaBlast paper, 
with the image facing down, over the garment.  Close the heat press.

6.)	After the allotted time, release the press and move the heat platen 
aside. While still hot, and with an even motion, peel the ChromaBlast 
paper off the garment (hot peel), and stretch the image area from 
top to bottom and side to side to reduce the hand on the fabric.

IMPORTANT:  Due to variations in garments and heat presses, these settings 
may vary. For best results, test different time/ temperature combinations to 
find one that works best with your garment/ heat press combination.  Please 
note, higher temperatures generally require less time to prevent scorching.  
An insufficient time/ temperature combination may hinder ChromaBlast 
from completely curing to the cotton fibers, thus resulting in wash out.

ChromaBlast / ChromaBlast-R (Suggested Press Parameters)
U.S. Europe

Temperature 375°F - 400° F 190°C - 204°C

Pressure 60 psi (High) 4.22 kg/cm2; 4.14 bar

Time 40 sec – 25 sec 40 sec – 25 sec

STORAGE INSTRUCTIONS

Store ChromaBlast Media in a cool, dry environment.  Do not remove 
media from protective packaging until ready to use.  Once packaging 
has been opened, store media in the plastic zip-loc bag provided.
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NOTES
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About Your ChromaBlast Driver  Software
Sawgrass Technologies, Inc.’s ChromaBlast  System with ChromaBlast™ Digital 
Printing Inks, featuring the  Epson WorkForce 30/T30/B40W, comprise a few of the 
key tools required to ensure high quality output each time you print. ChromaBlast Driver  
Color Management Software provides everything else needed in the way of tools.

ChromaBlast Driver  Color Management Software is a professional grade color 
management program that provides  ChromaBlast™  users with the necessary tools to 
ensure colors print right the first time.  ChromaBlast Driver  software is available for 
all major Windows based operating systems. To be sure of system compatibility, please 
visit us at http://www.sawgrassink.com/v.php?pg=296.

ChromaBlast Driver  software and profiles are intended to give you simple, easy to use 
color management tools to take the guesswork out of color printing.  With the click of 
your mouse you can automatically optimize colors for virtually any cotton substrate. This 
is a valuable tool that saves you time, money, and limits your need for costly sampling 
trying to get the job right.

ChromaBlast Driver  also comes standard with the ColorSure Palette matching system.  
The ColorSure Palette is absolutely the best way to achieve spot color accuracy in 
sublimation transfers. The palette includes more than 170 colors that, when loaded into 
your graphic design software, allows you to fill solid portions of artwork with a color 
from the palette, thus knowing how it will look once transferred. With the help of the 
ColorSure Palette, you will successfully choose the correct colors, whether you are 
matching colors for a custom order or selecting colors for new artwork.

ChromaBlast Driver  is the most advanced color management software available on the 
market for digital transfer systems. This software was developed specifically for desktop 
sublimation systems; you will discover enhanced functionality as well as a new level of 
color output when ChromaBlast Driver  is used. You and your customers are about to 
truly experience the next generation in digital color!

SYSTEM REQUIREMENTS

Minimum Hardware and Recommended Operating System:

•	 A Pentium Dual Core, 3.0 GHz or higher processor is recommended.

•	 512 MB RAM is the minimum recommended memory.

•	 2 GB RAM is highly recommended to process larger documents with high quality
	 settings.

•	 5 GB of Free Hard Drive is required for proper software and file management.
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Product Overview – ChromaBlast Driver 
ChromaBlast Driver  is a color management software solution that has been written as a 
windows printer driver.  It is designed to work with Epson ink-jet printers and Sawgrass 
sublimation ink.  The installation program will automatically install the Sawgrass 
ChromaBlast Driver  Printer Driver software, and ColorSure tools and utilities.

Step By Step Installation – ChromaBlast Driver 
	 1.	 The Welcome screen is displayed.  Click Next to proceed. 

	 2.	 The License Agreement is displayed next.  Select the appropriate choice for
				    acceptance of the License Agreement to continue.

Figure 1

Figure 2
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	 3.	 Choose the various components for installation. Check the boxes next to the
			   components you want to install, and uncheck the boxes next to the components
			   you don’t want to install. Click “Next” to continue.

	

	 4.	 Setup will install “ChromaBlast WorkForce 30,/ T30,/B40W” in the following
			   folder. To install in a different folder, click “Browse” and select another folder.
			   Click “Install” to start the installation.

Figure 3

Figure 4
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	 5.	 As installation proceeds, the screen below may appear periodically to indicate the
			   degree of installation accomplished.	

	 6.	 This “File Progress” Screen also shows repeatedly to keep you up-to-date.

			�  
�
	 7.	 If you see the “Hardware Installation” Screen below, click “Continue Anyway”
		  to proceed with the Installation.

Figure 5                  

Figure 7                 

Figure 6                 
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	 8.	 This “File Progress” Screen once more to keep you up-to-date.

	 9.	 If you have not previously registered the ChromaBlast Driver, you will be prompted
		  to do so.  Registering is the only way to take full advantage of the advanced
		  features in ChromaBlast Driver. If you choose to register later, select “Register
		  Later” and click “Next” to proceed with the installation. (Fig. 4) You will have
		  five days to use the program before registration will be required for continued usage
		  of the software. After five days, if you attempt to print using the ChromaBlast Driver
		  Software,you will be prompted to register. (Fig. 5)
	

Would you like to register this product now?

Figure 9                  

Figure 8                  

If you decide to register later, and continue using the driver during 
the initial five day pre-registration grace period, your system will 
generate the following Pop-Up Screen. Go to the printing preferences 
page of the ChromaBlast WF 30/T30/B40WDriver and click on 
“Register.”
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10.	In the ChromaBlast Registration Screen shown next, (Fig. 11), you will use your
		  Product ID (displayed at the bottom of Figure 11), to register and obtain a
		  Registration Code.  A Registration Code, (or Codes), may be had in any of the
		  following ways:

	 			   a)		 Register on-line and receive your Registration Code via E-mail.

			  b)		 Call Sawgrass Technologies, Inc. directly (888) 253-1679 and obtain your
					    code over the Phone.

			  c)		 Send a fax and receive your Registration Code by Fax.

  			  You must have a separate Registration Code for every machine on which
		  ChromaBlast WF 30/T30/B40W is installed.  The swiftest procedure by far is
		  option a), by E-mail, in which case, in Figure 11, click on the button
		  labeled“Click here to Obtain Registration Code”.

Figure 10
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	 11.	The Product Registration Web Page now opens.  Complete the requested
		  information on the web page and click Continue.

 

	 12.	Once the website registration information has been completed, a “Thank You” 	
		  message will appear. 

Figure 11                 

Figure 12               



27
Sawgrass Technologies, Inc. ~ Epson® WorkForce 30/T30/B40W ~ ChromaBlast™  

	 13.	After the online registration process is complete, apply the “Registration Code”
		  you’ve received in the box labelled “Registration Code”, then click “Apply Code”.

	 14.	Your driver is now registered. Installation begins when you click “OK”.

Figure 13                

Figure 14             
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	 15.		 The Color Management Check screen will appear. Click the “Continue” Button
		  on the left side of the screen after you have disabled the Color Management 	
		  feature of the Corel or Adobe Graphic software. Click “Show Me How” if you
				    need instructions on how to accomplish this.

	 16.	With this Screen, Installation of the ChromaBlast Driver will begin. The
		  installation will continue for some time, depending on the characteristics of
		  your hardware. Click “Close” to continue.

Figure 15                

Figure 16           

NOTE:	 In order to use ChromaBlast Driver as your Color Management 
Software, the color management features in either Corel® or Adobe® 
Programs must be disabled.  Please see the instructions in Appendix 
(Page 20), or click on the “Show Me How” Button on the “Color 
Management Check” Screen shown in Item 12 below.



29
Sawgrass Technologies, Inc. ~ Epson® WorkForce 30/T30/B40W ~ ChromaBlast™  

	 17.	“ChromaBlast Driver” Installation is done. Click “Close” to continue.

Figure 17         
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Using the ChromaBlast Driver for the WF 30/T30/B40W
ChromaBlast WF 30/T30/B40W is simple to use. Whenever you have ChromaBlast inks 
in your printer, you should print using the ChromaBlast Driver for the WF 30/T30/B40W.  
Do not print to your Epson printer with the Epson Printer Driver; printing with the Epson 
Driver will not give you the benefit of color management.

Quick Start Example (Corel Draw)
	 1)	 Open/Create an image in Corel Draw.  Select “Print” from the File Menu.    

	 2)	 Select the ChromaBlast WF 30/T30/B40W  Driver. Use the “Properties” Button
		  (Fig. 2) to access “ChromaBlast WF 30/T30/B40W  Driver Properties”.
		  (Fig. 3, Page 31)

ChromaBlast WorkForce 30

Figure 2

Note:	 Please  see “Group 2 - Color Options” on page
		  40 for more in-depth information on color
		  options available within the ChromaBlast
		  WF 30/T30/B40W  Driver.

Figure 1                 



31
Sawgrass Technologies, Inc.~Epson® WorkForce 30/T30/B40W~ChromaBlast™

	 3)	 In Figure 3, you must set preferences according to the printing you require,
		  either “Photographic”, “Graphics”, or “No Color Management”. You need 
		  also choose Paper Size, Number of Copies, “High Speed” or “High Quality”,
		  “Mirror” or not, and “ColorSure” involvement, if any. Once this is done, click 
		  “OK” to return to the “Print” Window (Fig. 2). Here, click on “Apply”, and then “Print”.

Figure 3
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Setting ChromaBlast WF 30/T30/B40W Document 
Properties /Printing Preferences
To  properly configure  the ChromaBlast Driver  for the WF 30/T30/B40W, you must
display its Document Properties/Printing Preferences. There are two ways to display the
Document Properties/Printing Preferences:

From the Windows Desktop:
1.	 Click on Start > Printers and Faxes.

2.	 Right-click  on  your  ChromaBlast  WF  30  Printer. (Point 1) Scroll the
	 Drop-Down Menu and click on “Properties”. (Point 2) This leads to the
	 ChromaBlast WF 30/T30/B40W  Driver Properties Window. (Fig. 3, Page 33)
	

Figure 2

Figure 1

1

2



33
Sawgrass Technologies, Inc.~Epson® WorkForce 30/T30/B40W~ChromaBlast™

3.	 In the “ChromaBlast WF 30 Properties” Window, click on the “Printing Preferences”
	 Button near the bottom of the screen in Fig. 3.  

Figure 3
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4.	 In Figure 4, you must set preferences according to the printing you require, either
	 “Photographic”, “Graphics”, or “No Color Management”.  You need also choose
	 Paper Size, Number of Copies, “High Speed” or “High Quality”, “Mirror”
	 or not, and “ColorSure” Involvement, if any. Once this is done, click on
	 “Apply”, then click “OK” to return to the “Properties” Window (Fig. 3, Page 35).
	 Once again, click on “Apply”, then click “OK”, returning you to the “Printers
	 and Faxes” Window in Fig. 2. 
	

Figure 4
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From an Application:
1.    Select File > Print Setup.  Click to reveal “Print Setup”. (Fig. 2)

2.	 Choose the ChromaBlast WF 30W Printer from the list of printers. Click the
	 Properties Button  to  access  the  ChromaBlastWF 30 Document Properties.

ChromaBlast WorkForce 30

Figure 1                  

Figure 2                  
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3)	 In Figure 3, you must set preferences according to the printing you require, either
	 “Photographic”, “Graphics”, or “No Color Management”.  You need also choose
	 Paper Size, Number of Copies, “High Speed” or “High Quality”, “Mirror” or not, 	
	 and “ColorSure” involvement, if any. Once this is done, click on “Apply”, then click 
	 “OK” to return to the “Print”Window (Fig. 2). Here, click on “OK”, and then “Print”.

Figure 3
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ChromaBlast Driver Properties
The Figures below show the Document Properties/Printing Preferences for a registered
version of ChromaBlast  Driver.
There are three main property groups. (See the color-coded boxes in the screen
shot, Fig. 1, Page 39.):

Group (1): 	Configuration  	Set Paper Size and Copy Count.
Group (2): 	Color Settings  	Color Management Control Options.

Group (3): 	Options  	Utilities for Printer Maintenance, Online Help, Product
				    Registration, and Setting Input Profiles.

	 ChromaBlast Driver

Figure 1                  
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Group 1_Configuration: ChromaBlast Driver

Paper Size – From the drop down list, select the paper size you wish to use.

Copies – Sets the copy count for the number of prints to be made.

Group 2_Color Settings: ChromaBlast Driver

This tab gives you access to all of the color management controls available in ChromaBlast  
Driver.  Color correction allows you to create transfers from all kinds of images, from 
photorealistic images to spot color logos.  

Color Options
•	 No Color Management - All color management will be accomplished using the 	
	 Graphic Design Software.

•	 Graphics - This setting is most suitable for reproducing life-like clipart.

•	 Photographic - This setting is most suitable for reproducing skin tones in scanned
	 photographs.

 •	 ColorSure Checkbox - ColorSure* is used to replace specific colors in your image with
	 A spot color chosen from the ColorSure Palette. This resulting spot color enhancement
	 is not affected by color setting.  A ColorSure spot color will ALWAYS print the same.

*See Appendix B for an overview of ColorSure, Page 48.

ColorSure Options
•	 Print Palette Button – Prints the ChromaBlast ColorSure Palette for the selected
	 substrate. ColorSure is a method for reproducing exact spot colors.  The two main
	 components are: 1) the Transferred Palette and 2) the CorelDraw, and Adobe
	 Swatches. For a complete description on how to use ChromaBlast ColorSure to get
	 perfect spot colors, see Appendix C.

•	 Custom Palette Button – This button launches the Custom Palette Utility, which
	 enables you to add, edit, import, and export custom colors to the ColorSure Palette.  
	 If you need to precisely match a specific color, the Color Finder Tool makes this
	 a breeze.  For a complete description on how to use the Custom Palette,
	 see Appendix C.

Output Options
•	 High Speed – If the printer supports multiple resolutions, choose the most
	 appropriate setting.  For soft substrates, the High Speed option works well.

•	 High Quality – If the printer supports multiple resolutions, choose the most
	 appropriate setting.  For hard substrates, choose the High Quality option.

•	 Mirror – When you transfer an image, the result will be “flipped” when compared 	
	 to the printed image.  In order for your transfers to come out correctly, you must 	
	 flip the image before transferring.
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Group 3 – Printer Options: ChromaBlast Driver

•	 Utilities – Click this button to display a Utilities Screen.  From the Utilities Screen 
	 you can print a Nozzle Check pattern, run a print head Cleaning Cycle,align the 
	 printer’s Print Head, spool a ChromaBlast  Driver print file to the printer, and
	 print a page of primary ink colors.

•	 Help – This will display a help dialog box for an easy overview of the ChromaBlast
	  Driver™  driver functions and settings.  Also contains a link to the Sawgrass
	 Technologies Website.

•	 Register – If the ChromaBlast  Driver™ product has not been registered, 		
	 click this button for instructions on how to register the product and unlock all the
	 features.

•	 Input Profile – This option allows you to specify an input profile that the driver will
	 use when color correcting your image.  If you are printing scanned artwork and 	
	 your scanner manufacturer provided ICC profiles for your scanner model, select 	
	 the profile here   In order to select a profile IT MUST BE INSTALLED ON YOUR
	 MACHINE.  To install a profile on your machine, locate the profile on your machine
	 using Windows Explorer. (ChromaBlast  Driver supports both ICC and ICM
	 Profile types).  Right click on the profile file name and select “Install”.
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Appendix A:
Over-Riding Design Software Color Management
The ChromaBlast  WorkForce 30  provides a complete color management solution for 
your ChromaBlast Digital Transfer Inks printing.  It is extremely important that you turn 
off any color matching features associated with your design software. An explanation of 
how to disable print-time color management in several popular design packages follows:

CorelDraw™ version X-4, X-3, 12, 11, and 10
•	 In CorelDRAW, open an existing, or create a new graphic.

•	 From the Main Menu choose Tools > Color Management. 

Figure 1                  

Figure 2                  
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•	 In the Color Management Window, set the Style option to Color Management Off.

CorelDraw™ version 9
•	 Create a new graphic.
•	 From the Main Menu choose Tools > Color Management. The Color Management
	 Dialog Box is displayed.
•	 In the Color Management Window (see figure below), UNCHECK the Calibrate
	 colors for display box.
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Adobe Photoshop CS3, CS2, CS, Photoshop 7 & 6:
	 Color Setup 
		  From the Main Menu, choose Edit, > Color Settings. In the Color Settings 	
		  Dialog Box, turn all Color Management Policies to “Off”. (See below.)  Mark
		  the box “Ask When Opening” next to “Profile Mismatches.

 

  

To Print; Adobe CS3:
Select File, > Print.  On the print dialog page, set the options as follows:
•	 Upper Right Hand Menu to “Color Management”
•	 Choose “Document” by clicking the radio button.
•	 Under “Color Handling”, choose “No Color Management”
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To Print; Adobe CS2, 
Always select File, > Print with Preview.  On the print dialog page, 
set the options as described in the following a thru d:
a.	 Click on “More Options”.

b.	 Choose Color Management in the drop-down menu.
c.	 Choose “Document” by clicking the radio button.“
d.	 Under “Options > Color Handling” choose “No Color Management”. 
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To Print; CS and Photoshop 7:
Always select File, > Print with Preview.  On the print dialog page, 
set the options as described in the following a thru d:
	 a.	 Click on “More Options”.
	 b.	 Choose Color Management in the drop-down menu.
	 c.	 Choose “Document” by clicking the radio button.
	 d.	 Choose Same as Source for Print Space.
From the Color Management drop option list, make sure that Source is 
set to “Document” and Print Space is set to “Same As Source”.
 

Adobe Photoshop Elements 5.0/4.0/3.0:
	 Select Edit and then Color Settings from the top drop down Menu Bar
	 Select No Color Management. Click Ok.

a
b
c

d
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To Print RGB Graphics

Click File, > Print, then set the 
Range, Print Quality, & Copies.

Fill in radio button “Document: 
Intagged RGB”.

In “Print Space”, “Profile” should 
read: “Same As Source”.

Press “OK”.

To Print CMYK Graphics

Click File, > Print, then set the 
Range, Print Quality, & Copies.

Fill in radio button “Document: 
Intagged CMYK”.

In “Print Space”, “Profile” should 
read: “Printer Color Management”.

Press “OK”.



Sawgrass Technologies, Inc. ~ www.sawgrassink.com
46

Appendix B:
Using ChromaBlast ColorSure™ and Custom Palette 
I.  Introduction
ColorSure is a method for reproducing exact spot colors.  There are four main 
components of the ColorSure System: 1) the Transferred Palette; 2) Color Finder; 3) 
Custom Palette; and 4) the CorelDRAW and Adobe application palettes / swatches.  

	 1.	 ColorSure Palette: This is your main color palette that includes a wide variety
		  of commonly used colors.  
	 2.	 Color Finder:  If a color you need is not on the ColorSure Palette, the Color
		  Finder Tool allows you to locate the exact custom color you are looking for.
	 3.	 Custom Palette:  With the Custom Palette feature, you can add new custom
		  colors to the existing ColorSure Palette mentioned in Step 1.
	 4.	 Application Palettes: You can add your Color Finder colors to an existing
		  application palette, or you can add multiple custom colors to new,
		  custom palette files (*.cpl, *.acl, etc.). 

II.  Printing the ColorSure Palette
			   The first step:	  Print and transfer your ColorSure Palette to the
			   various substrates you will be using.  Most likely you will have customers who
			   desire precise colors.  Having your ColorSure palette available allows the
			   customer to choose the color from the palette that is the closest match to
			   what they want, and this gives you a starting point for finding the exact
			   custom color that will match your customer’s needs. 

To print the ColorSure palette, follow the steps below:
	 •	 Click ‘Start’ and navigate to the ‘Printers and Faxes’ folder.  Right-click on
		  your ChromaBlast WorkForce 30 icon and select ‘Printing Preferences’ from
		  the	 menu. You may also open ChromaBlast  WorkForce 30   from within an
		  Adobe or Corel program by going to File, Print, and choosing the ChromaBlast
		  WorkForce 30 printer from the pull-down menu.  Click “Properties” to open
		  ChromaBlast WorkForce 30. Select the ChromaBlast WorkForce 30 Tab.
	 •	 Choose the paper size you will be printing the palette to (Letter, Legal, etc).
	 •	 Select the speed / resolution of the palette – High Speed or High Quality.
	 •	 Be sure to check the box to mirror your print, click ‘Print Palette,’ and then transfer
		  the palette to the previously selected material.
	 •	 You now have a visual representation of how the ColorSure Palette colors will 	
		  appear on that particular texture, tone, and weave of material.
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HINT
After you have the ColorSure Palette loaded into CorelDraw, move the 
cursor over each color.  As the cursor hovers over each different color, 
the ColorSure Name is displayed in the status area below each color.

2

1

III.  Designing Your Artwork
By picking colors from the ColorSure palette, you will be able to consistently 
reproduce colors in a reliable manner.  To assist you in designing your artwork, 
ChromaBlast ColorSure & ChromaBlast WorkForce 30 installs three palettes:  two 
for Adobe products and one for Corel products.  These colors match the palette that 
is printed from within ChromaBlast ColorSure and the ChromaBlast WorkForce 30. 
	 •	 To open the ColorSure Palette in Corel 9, 10, 11, 12, X3, and X4, choose Window
		  > Color Palettes > Open Palette.  Select the file “ColorSure PaletteCorel.cpl”
	 •	 To open the ColorSure Palette in Adobe Illustrator, (Colorsure Palette.aco)
		  choose Window > Swatch > Libraries > Other Library.  Navigate to its Installation
		  Destination set during WorkForce 30  installation: C:\Program Files \Sawgrass
		  \WorkForce 30 \Adobe Illustrator and hit Open. For easier access to the Palette
		  File, copy it from this installation path to Illustrator10 \Presets \Swatches and
		  it will show up in your Drop-down list directly under the Swatch Libraries Menu.
		  Other versions of Illustrator will have similar steps.
	 •	 To open the ColorSure Palette in Adobe PhotoShop, (Colorsure Palette.aco) 
		  choose the “Swatches Palette”, click the option arrow on the palette, (Point 1),
		  choose Replace Swatches, (Point 2), and pick the “Colorsure Palette.aco file.

 

IV.	Using Color Finder
After printing and transferring the ColorSure Palette, you see that you have an array 
of colors to work with.  There will be times, however, when the color you need is not 
included in the ColorSure Palette.  This is where the Color Finder Tool comes in handy.  
The Color Finder Tool allows you to start with a specific color (e.g. navy blue) and find 
similar colors in the same family by adding and subtracting up to three colors called
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Figure 1

Figure 2
Figure 3

Slider
Bar

Color Chooser Dialog Window

•	 To use Color Chooser, simply click on the‘Start
	 Color Chooser’ button in the “Color Finder”
	 Section, at the top right of the “ChromaBlast
	 Custom Palette Utility” Window.  You can then
	 choose a color from the basic color selection, or
	 you can click on the Color button at the right of
	 the window.  This will display a color matrix.  To
	 define a custom color, click anywhere in the matrix.
	 Use the slider at the right of the matrix to adjust
	 luminosity. Clicking ‘OK’ will automatically fill the
	 RGB boxes with the corresponding values. (Fig. 3)	
•	 For advanced users, RGB values can be
	 determined by printing out a Custom Palette,
	 which is outlined in the next section.

‘Step Colors.’  For example, starting with navy blue with a CMYK value of 
60,60,0,40 and choosing two step colors (e.g. cyan and magenta) would 
expand the original navy blue in four directions (more cyan, less cyan, more 
magenta, and less magenta).  This expanded color chart – specific to a particular 
substrate and printing speed – is outputted directly to your printer.

How to use Color Finder:
	 •	 Open the ChromaBlast  WorkForce 30  Window as instructed in “Printing the
		  ColorSure Palette” outlined in Section II.
	 •	 At the bottom of the window, click the Custom Palette Button; this will open
		  the 	“Custom Palette Utility” Window.  (Figure 1)
	 •	 First, make sure you select your desired Substrate, Output (High Speed or High 
		  Quality), and the Mirror option from the Printing Preferences Window.  Click
		  Apply at the bottom of the window.  This is a very important step as it will
		  affect the final printed output. (Figure 2)
	 •	 Click on Color Chooser and select your desired starting color from the matrix. 
		  If you do not wish to use Color Chooser, you have the option to manually enter
		  the Start Color values in the CMYK boxes. (Figure 3, page 51.)
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Custom Palette Utility
You may alter the chosen color’s CMYK value by selecting two or three Step Colors.
Using multiple step colors will present you with a greater range and variety of colors to 
choose from.
	 •	 For instance, if you choose to modify your Start Color with two steps,then Step
		  Color 1 will change its values on the X (horizontal) axis and Step Color 2 will
		  change its values on the Y (vertical) axis.  

Color Finder Palette with two Step Colors
	 •	 If you modify your Start Color with three steps, Step Color 1 will remain the 	
		  same.  However Step Color 2 and Step Color 3 will form an imaginary ‘X’ and 	
		  their values will change on opposing diagonal Y axes.

   

Color Finder Palette with three Step Colors



Sawgrass Technologies, Inc. ~ www.sawgrassink.com
50

	 •	 Next, determine what Step Size you want to apply to the Color Finder Palette.  	
		  This is simply a question of how much you want your Start Color to fluctuate.  
	 •	 If your Start Color is close the color you are looking for, use a low Step Size 	
	 	 (i.e. 	5-10).  However, if your start color is not close to what you are looking 	
		  for, 	use a higher Step Size.
	 •	 You can enter any Step Size value between 1 and 40.
	 •	 As an example, let’s say your Start Color is C:20, M:100, Y:150, K:0 and you 	
		  select Cyan and Magenta to be your Step Colors.  You also enter a Step Size 	
		  of 10.  When the ‘Print Colors’ Button is clicked,  your Start Color will be in 	
		  the middle of the Color Finder Palette and from there each color will vary the 	
		  Cyan and Magenta values by 10.
	 •	 When you are finished selecting the Start Color, Step Colors, and the Step 	
		  Size, click on the Print Colors Button.  This will print your custom Color 	
		  Finder Palette directly to your printer.
	 •	 After printing the Color Finder Palette, transfer it to your selected substrate 	
		  and 	then try to match your desired color to one that is on the palette.  If you 	
		  find 	a suitable match, you are finished using the Color Finder Tool.  Move on 	
		  to Section V. “The Custom Palette”. 
	 •	 If you couldn’t find an accurate match on the first printed Color Finder 		
		  Palette, don’t worry.  Follow the easy steps below, and you can find a more
		  suitable custom color.

To Find More Custom Colors

	 1.	 First, try to locate a new Start Color from the palette  is closer than the 		
		  original color.

	 2.	 Next, after finding a more suitable Start Color, write down that color’s CMYK 	
		  value.  Here is how to obtain this value.  There are numbers under each color 	
		  that are dependant upon which Step Colors you chose.  For example, it might 	
		  say C:70 M:120.  Take note of these values.  Then, at the bottom left of the 	
		  Color Finder Palette you will see a full set of CMYK values.  The new Start 	
		  Color’s CMYK value would be C:70, M:120 and whatever the Y&K values are 	
		  from the full set.

	 3.	 Lastly, plug the CMYK values for the new Start Color into the boxes in Color 	
		  Finder, choose your Step Size, and click on Print Colors once again.  
		  Continue with steps 1-3 until you find your desired color.
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V.	 The ChromaBlast Custom Palette
Let us assume that you have found the exact color you need using the Color 
Finder Tool.  What you will want to do next is apply these custom color values 
to either an existing palette, or to create a new custom palette altogether.  
This allows you access to this color again should the same job arise.  

How to use Custom Palette:
	 •	 First, you need to assign the CMYK values of the matched color from the Color
		  Finder Palette to the Output Color CMYK fields in the Custom Palette section.

	 •	 Give your new custom color a descriptive Name in its designated field
		  (e.g. IBM Blue).

	 •	 Next, assign an “RGB Input Color” Value.  There are two methods to establish 
		  this value.

	 1.	 If you have the original file, sample the color that was matched in your graphic
		  design application with the eye dropper tool.  This will give you the RGB value
		  of that color.  Input this value into the RGB Input Color fields of the CustomPalette
		  Section.

	 2.	 If you do not have the original file, or the artwork has not yet been designed,simply 
		  click on the ‘Input Color Chooser’ button, and then click on “Define Custom
		  Colors”.  From the color matrix, find a color that closely resembles the color 
		  that you are adding to the custom palette.  At the bottom-right of the colormatrix 
		  window are the RGB values.  Simply click ‘OK’ and the RGB InputColor values 
		  will be automatically entered.  Please take note of these RGB values for later use
		  in your design applications.

	 •	 Click the “Add Color” Button.  A window will pop up asking you whether you
		  want to add the color to the palette for all substrates, or just the currentsubstrate.
		  Click ‘YES’ here unless you have the same custom color saved on palettes for
		  other substrates.  Another window will then ask you if you want to save the
		  custom color for all resolutions or just the current one.  Click ‘YES’here unless
		  you have the same custom color saved on palettes for other resolutions.

	 •	 Lastly, click the “Save Palette” Button.  When finished, simply Exit out of the
		  window.

					     The ‘Import Palette’ and ‘Export Palette’ Buttons are convenient to
					     have in the event you need to transfer palettes to and from different
					     computers.

VI.	Adding Swatches to your ChromaBlast Application Palette:
It is possible to add your custom color(s) swatch to an application palette 
as well.  You will need to take note of the Input Color RGB value that you 
assigned in the previous step in order to create the new swatch.  Refer to your 
specific design application software’s manual for instructions on this.
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Supplies & Equipment 
Contact your authorized reseller to purchase sublimation supplies and equipment. For 
more information, see the Dealer Directory on our website at www.sawgrassink.com.

Operating Conditions
Certain environmental conditions should be taken into account for the operation 
of ChromaBlast Inks, including temperature and relative humidity.

	 ChromaBlast
	 •	 Supported operating Conditions are 65° – 80° F with 5 – 60% relative humidity

	 •	 Optimum operating Conditions are 70° – 75° F with 40 – 50% relative 		
		  humidity

Storage
	 •	 Care should be taken to prevent storing ChromaBlast inks below freezing
		  temperatures (32°F, 0°C). Do not expose these inks to extreme heat
		  (temperatures in excess of 104°F, 40°C). If these inks have been in storage,
		  you should allow them to reach room temperature before using them.  

	 •	 Do not expose ChromaBlast cartridges directly to light, especially sunlight, for
		  extended periods. 

	 •	 For best results, install your ChromaBlast cartridges by the date on the
		  cartridge. Please refer to the individual ink bag/cartridge for the specific
		  ink expiration date.

Storage Instructions
Store ChromaBlast Media in a cool, dry area within the provided plastic storage bag.  Do 
not remove from carton until ready to use.
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Troubleshooting
The troubleshooting tips found in this section relate mainly to problems that 
can be seen in transferred ChromaBlast images. If you are having problems 
related to the performance of your printer, please refer to the Problem Solving 
section found in the Epson Stylus Photo  Printer Quick Reference Guide.

The colors in my transferred image are incorrect.
	 •	 The image may need color adjustment. Use the WorkForce 30 color matching
		  software. For more information on how to use this software, please see the
		  relevant User Guide Sections on Color Management.
	 •	 Ensure you used the right Printer WorkForce 30 and WorkForce 30 settings.
		  Please see the relevant User Guide Sections related to Software.
	 •	 Ensure you pressed the item with the proper time, temperature, and pressure.
		  For guidelines see the section entitled ChromaBlast Transfer Instructions, Page 8.
	 •	 Verify that all colors print correctly. Run the Nozzle Check utility and clean the
		  print heads as required.

My printout is really light on paper.
	 •	 ChromaBlast Ink naturally looks muted before heat transferrance of the image. After
		  transferring is complete, ChromaBlast’s unique inks will produce a brilliant
		  and durable final product. 

My printout gets cut off on the bottom or side.
	 •	 Verify the WorkForce 30 Printer is setup for the correct paper size. Your
		  WorkForce 30 Printer setting needs to match the paper size that is loaded
		  in your printer.
	 •	 Ensure the right paper guide is in the proper position. When setting up the printer,
		  slide the right paper guide to the left until it clicks into position.

My image looks good but it washes out.
	 •	 Ensure you pressed the garment with the proper time, temperature, and
		  pressure. If so, try pressing longer to ensure that the dyes are penetrating the 
		  fibers sufficiently. For guidelines, see the section entitled  ChromaBlast Heat
		  Transfer Instructions.
	 •	 With ChromaBlast, ensure you used the recommended ChromaBlast v1.5
		  Media and Inks.
	 •	 Ensure your substrate is designed to accept sublimation transfers. Garments
		  made from natural fibers, such as cotton, are not compatible with the
		  sublimation process.

Colors are light and splotchy.
	 •	 Ensure you printed on the correct side of the paper or other media. With paper, 
		  the print side is the bright white side.
	 •	 Ensure you pressed the item with the proper time, temperature, and pressure.
		  For guidelines, see the section entitled ChromaBlast Transfer Instructions,
		  Page 17.
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	 •	 Verify your printer WorkForce 30 settings are correct. Please see the relevant
		  sections of the User’s Guide for additional information.
	 •	 Ensure your substrate is designed to accept a ChromaBlast transfer. Garments
		  made from natural fibers such as Cotton are compatible with the ChromaBlast
		  sublimation process.

My image looks blurred.
	 •	 Ensure you pressed the item with the proper time, temperature, and pressure. For
		  guidelines, see the section entitled ChromaBlast Transfer Instructions, Page 17.
	 •	 Ensure you printed on the correct side of the media. The print side is opposite the
		  LOGO side of the media.
	 •	 Verify that the printer’s print heads are properly aligned. For further instructions, 
		  see the Epson WorkForce 30 Printer Quick Reference Guide.

My image has gaps or bands present.
	 •	 Ensure that all of the printer’s nozzles are firing properly.  Perform a Nozzle Check
		  from the Utility Tab of your printer WorkForce 30. For further instructions, see
		  the Epson WorkForce 30 Printer Quick Reference Guide.
	 •	 If one or more of the nozzles fail to print, perform a Print Head Cleaning. For
		  Further instructions, see the Epson WorkForce 30 Printer Quick Reference
		  Guide.
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Technical Support
If you are having difficulties achieving good results from your ChromaBlast
Inks, you have several support options:
1.	 Telephone: You may contact your authorized ChromaBlast reseller during their
	 normal hours of operation for assistance. A full listing of authorized ChromaBlast
	 Resellers is available on our Web Site at www.sawgrassink.com. In addition, you
	 may also contact Sawgrass Technical Support at (888) 253-1679 between the hours
	 of 8:30 AM and 5:30 PM Eastern Standard Time. 

2.	 Internet: Visit the Technical Support area of the Sawgrass Technologies, Inc.’s
	 Web Site at www.sawgrassink.com.  The troubleshooting utility found here will
	 provide you with solutions to some of the most common problems.  You may submit
	 a detailed description of your problem if you need further assistance. 

3.	 E-mail: You may e-mail Sawgrass Technical Support with a detailed description
	 of your problem at support@sawgrassink.com. 

4.	 Fax: You may fax a detailed description of your problem to Sawgrass Technical
	 Support at (843) 849-3847.



Notes:
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